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ภาคผนวก ก 
 

คูมือการติดต้ังและขั้นตอนการทํางาน 
ระบบใหบรกิารวัสดุสารสนเทศของศูนยภาษา มหาวิทยาลัยราชภัฏอุตรดิตถ 

 
การติดต้ังระบบใหบริการวัสดุสารสนเทศของศูนยภาษา มหาวิทยาลัยราชภัฏอุตรดิตถ จะมี

สวนประกอบที่จําเปนในการติดต้ังเพื่อใชงานคือ 
1. โปรแกรมฐานขอมูล MySQL 4.0  
2. โปรแกรม SQLyog Enterprise MySQL GUI โปรแกรมจัดการฐานขอมูล MySQL  
ผูเขียนขอขามข้ันตอนการติดต้ังโปรแกรมฐานขอมูล MySQL 4.0 และการติดต้ังโปรแกรม 

SQLyog Enterprise MySQL GUI  สวนการติดต้ังระบบใหบริการวัสดุสารสนเทศของศูนยภาษา 
มหาวิทยาลัยราชภัฏอุตรดิตถสามารถทําตามข้ันตอนดังนี้ 
 
ก.1 การติดตัง้โครงสรางฐานขอมูล MyLCLAB 

1. ใสแผนซีดีรอมโปรแกรมท่ี ซีดีรอมไดรฟ (CD-ROM DRIVE) 
2. เปดโปรแกรม SQLyog Enterprise MySQL GUI เรียกใชโปรแกรมโดยการเขาไปท่ี 

START > All PROGRAMS > SQLyog Enterprise > SQLyog Enterprise 
3. จะปรากฏหนาตางเพื่อทําการติดตอกับฐานขอมูล MySQL 4.0 ดังรูป ก.1 
 

 
 
 
 
 
 
 
 
 

รูป ก.1 หนาตางเพื่อทําการติดตอกับฐานขอมูล MySQL 4.0 
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4. เม่ือกรอกขอมูลสําหรับติดตอกับโปรแกรมฐานขอมูล MySQL ครบ กด Connect เพื่อ
ทําการเขาสูระบบ จะเขาสูหนาจอการทํางานของโปรแกรม SQLyog MySQL GUI ดัง
รูป ก.2 

 
รูป ก.2 หนาจอการทํางานของโปรแกรม 

 
5. จากนั้นคลิกท่ีเมนู File > Open  หรือ กดคียลัด Ctrl+O ดงัรูป ก.3 

 
รูป ก.3 เมนู Open 
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6. ทําการเลือกไฟล MyLCLAB.sql จากไดเรกทอร่ี sql จากแผนซีดีโปรแกรมท่ี ซีดีรอม
ไดรฟ (CD-ROM DRIVE)  แลวคลิกปุม Open เพื่อทําการเปดไฟล MyLCLAB.sql ดัง
รูป ก.4 

 
 
 
 
 
 
 
 
 
 
 
 

รูป ก.4 เลือกไฟล MyLCLAB.sql จากไดเรกทอร่ี sql 
 

7. ท่ีหนาตาง Query ของโปรแกรม SQLyog  Enterprise MySQL GUI  จะปรากฎ script 
การสรางฐานขอมูล MyLCLAB ดังรูป ก.5 

 
รูป ก.5 หนาตาง Query โปรแกรม SQLyog Enterprise MySQL GUI 
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8. การประมวลผลชุดคําส่ังจากไฟลท่ีเปด โดยไปท่ีเมนู Edit > Excute Query > Excute 
All Queries หรือกดคียลัด Shift+F5 ดังรูป ก.6 
 

 
รูป ก.6 ประมวลผลชุดคําส่ัง 

 
9. หลังจากทําการประมวลผลชุดคําส่ังเสร็จแลว เลือกเมนู  Edit > Refresh Object 

Browser หรือ กดคียลัด F9  ดังรูป ก.7 

รูป ก.7 ประมวลผลชุดคําส่ัง 
 

10. โครงสรางฐานขอมูล MyLCLAB ท่ีติดต้ังเรียบรอยจะปรากฏข้ึน ดังรูป รูป ก.8 
 

รูป ก.8 ประมวลผลชุดคําส่ัง 
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ก.2 การติดตัง้ระบบใหบริการวัสดุสารสนเทศของศูนยภาษา 
1. ใสแผนซีดีรอมโปรแกรมท่ี ซีดีรอมไดรฟ (CD-ROM DRIVE) 
2. ในระบบท่ีซีดีรอมสามารถเปดไดโดยอัตโนมัติ จะปรากฏหนางตางการติดต้ัง

โปรแกรม LC-Material-2007 ดังรูป ก.10 สวนระบบที่ปดการทํางานแบบอัตโนมัติ
ของซิดีรอมใว ใหคลิก Start > Run พิมพ <CD Drive:>\AutorunCD (จากรูป ก.9 
ซีดีรอมไดรฟในระบบที่ติดต้ังเปนไดรฟ f:\ ท้ังนี้ไดรฟซีดีรอมอาจไมเหมือนกับ
ตัวอยาง ข้ึนอยูกับสภาพของระบบท่ีทําการติดต้ัง)  

 
รูป ก.9 เปดโปรแกรมติดต้ังดวยตนเอง 

 

 
รูป ก.10 หนาจอติดต้ังโปรแกรม 
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จากรูป ก.10 หนาจอตดิต้ังโปรแกรม ประกอบดวยรายการดังนี ้
รายการ ติดต้ัง LC-Material-2007 สําหรับติดต้ังระบบใหบริการวัสดสุารสนเทศ

ของศูนย ในสวนของผูดูแลระบบและเจาหนาท่ีศูนยภาษา 
รายการ ติดต้ัง LC-Student-2007 สําหรับติดต้ังระบบใหบริการวัสดุสารสนเทศ

ของศูนย ในสวนของผูดูแลระบบและเจาหนาท่ีศูนยภาษา 
รายการ จบการทํางาน สําหรับออกจากระบบติดต้ังโปรแกรม 

 
2.1 ข้ันตอนการติดต้ัง LC-Material-2007 

LC-Material-2007 หรือ ระบบใหบริการวัสดุสารสนเทศของศูนย มหาวิทยาลัย
ราชภัฏอุตรดิตถในสวนของผูดูแลระบบและเจาหนาท่ีศูนยภาษา มีข้ันตอนการติดต้ังระบบ
ดังนี้ 

1) เลือกรายการ ติดต้ัง LC-Material-2007 จะปรากฏหนาตางการติดต้ังระบบ
ใหบริการวัสดุสารสนเทศ ดังรูป ก.11 จากนั้นคลิก Next เพื่อทํารายการตอไป 

 
รูป ก.11 หนาจอติดต้ังโปรแกรม 

2) หนาตางแสดงไดเรคทอร่ีท่ีจะทําการติดต้ังระบบใหบริการวัสดุสารสนเทศ 
โดยคาเร่ิมตนของระบบจะทําการติดต้ังท่ี C:\Program Files\LC-Matearial-
2007 ดังรูป ก.12 จากนั้นคลิก Next เพื่อทํารายการตอไป 
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รูป ก.12 ไดเรคทอร่ีเร่ิมตนของระบบ 

 
3) จะปรากฏหนาตางสําหรับกําหนดชื่อกลุมของโปรแกรมท่ีจะปรากฏใน Start 

เมนู ดังรูป ก.13 จากนั้นคลิก Next เพื่อทํารายการตอไป 
 

 
รูป ก.13 หนาตางสําหรับกําหนดชื่อกลุมของโปรแกรม 
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4) คลิก Install เพื่อทําการติดต้ังระบบใหบริการวัสดุสารสนเทศ ดังรูป ก.14 

รูป ก.14 หนาตางแสดงรายการกอนการตดิต้ัง 
 

5) จะทําการติดต้ังระบบใหบริการวัสดุสารสนเทศ ดังรูป ก.15 หนาจอติดต้ัง
โปรแกรม 

รูป ก.15 หนาจอสถานะการติดต้ังโปรแกรม 
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6) เม่ือระบบทําการติดต้ังเสร็จแลวจะระบบจะทําการเปด config.ini ข้ึนมาเพื่อทํา
การกําหนดคาเร่ิมตนการติดตอฐานขอมูล 

ตัวอยางคาเร่ิมตนจากไฟล config.ini 
[Database Setup] 
Hostname=127.0.0.1 
Database=MyLCLAB 
User=root 
Password= 

 
Hostname หมายถึง ช่ือหรือหมายเลขเคร่ืองท่ีไดใหบริการโปรแกรม
ฐานขอมูล MySQL 
Database หมายถึง ช่ือฐานขอมูล ซ่ึงฐานขอมูลในท่ีนี้คือ MyLCLAB 
User  และ Password หมายถึง ช่ือและรหัสผานท่ีใชในการติดตอกับ
ฐานขอมูล ตามสิทธ์ิท่ีไดรับ 
 

2.2 ข้ันตอนการตดิต้ัง LC-Student-2007 
LC- Student -2007 หรือ ระบบใหบริการวัสดุสารสนเทศของศูนย มหาวิทยาลัย

ราชภัฏอุตรดิตถในสวนของผูใชบริการ มีลําดับข้ันตอนการติดต้ังและการกําหนดคา
เบ้ืองตนของระบบ คลายกันกับข้ันตอนการติดต้ัง LC-Material-2007 

 
ก.3 ขั้นตอนการทํางาน 
 จากการศึกษาระบบใหบริการวัสดุสารสนเทศของศูนยภาษา มหาวิทยาลัยราชภัฏอุตรดิตถ 
สามารถจําแนกข้ันตอนการทํางานของโปรแกรมไดดังนี้ 

 3.1 งานบริการโปรแกรมมัลติมีเดีย เปนการกําหนดใหผูใชบริการเขาใชโปรแกรม
มัลติมีเดียตามท่ีไดรับมอบหมายจากผูสอน โดยมีข้ันตอนดังรูป ก.16 โดยเร่ิมจากนําขอมูล
กลุมเรียนท่ีลงทะเบียนเรียนจากสํานักทะเบียน และอาจารยผูสอนสงขอมูลการเขาใช
โปรแกรมมัลติมีเดีย จากนั้นเจาหนาท่ีทําการบันทึกและกําหนดขอมูลการใชโปรแกรม
มัลติมีเดียของผูใชบริการ เม่ือผูใชบริการเขามาใชโปรแกรมมัลติมีเดียตามท่ีกําหนด ระบบ
จะทําการบันทึกขอมูลการเขาใชโปรแกรมมัลติมีเดียโดยมีข้ันตอนการทํางานดังรูป ดังรูป 
ก.17 
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รูป ก.16 ข้ันตอนกําหนดขอมูลการเขาใชโปรแกรมมัลติมีเดีย 

 

 
รูป ก.17 ข้ันตอนงานบริการโปรแกรมมัลติมีเดีย 

 
 3.2 งานลงทะเบียนวัสดุสารสนเทศ งานรับลงทะเบียนวัสดุสารสนเทศใหมและ
ปรับปรุงขอมูลวัสดุสารสนเทศ 

3.3 งานยืมวัสดุสารสนเทศ งานใหบริการยืมวัสดุสารสนเทศเพ่ือสนับสนุนการ
เรียนการสอน และการเรียนรูดวยตนเองมีข้ันตอนการทํางาน โดยหลักฐานผูใชบริการอาจ
เปนบัตรประจําตัวนักศึกษา บัตรประจําตัวหองสมุด บัตรอาจารย หรือบัตรเจาหนาท่ี หรือ
บัตรอ่ืนใดท่ีสามารถระบุตัวตนผูใชบริการได โดยมีข้ันตอนการทํางานดังรูป ก.18 
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รูป ก.18 ข้ันตอนงานยืมวัสดุสารสนเทศ 

 
 3.4 งานคืนวัสดุสารสนเทศ รับคืนวัสดุสารสนเทศของผูใชบริการ เพื่อใหวัสดุ
สารสนเทศของศูนยภาษาจะยังคงสามารถใหบริการแกผูมาใชบริการคนอ่ืนๆ ไดอยาง
ท่ัวถึงและมีประสิทธิภาพ และตรวจรับวัสดุสารสนเทศใหอยูในสภาพท่ีสามารถใชงานได 
และพรอมสําหรับการใหบริการยืมคร้ังตอไป โดยมีข้ันตอนการทํางานดังรูป ก.19 

 
รูป ก.19 ข้ันตอนงานคืนวัสดุสารสนเทศ  

 



 

ภาคผนวก ข 

 
คูมือการใชระบบใหบริการวัสดุสารสนเทศของศูนยภาษา 

มหาวิทยาลัยราชภัฏอุตรดิตถ  สําหรบัผูดูแลระบบ 
 
ระบบใหบริการวัสดุสารสนเทศของศูนยของภาษา มหาวทิยาลัยราชภัฏอุตรดิตถ ในสวน

ของผูดูแลระบบ พัฒนาข้ึนเพือ่เพิ่มขอมูลผูใชงานระบบใหบริการวัสดุสารสนเทศของศูนยของ
ภาษา สามารถทําตามข้ันตอนดังนี ้
 
ข.1 หนาจอหลักของการเขาใชระบบ 

1. ระบบใหบริการวัสดุสารสนเทศของศูนยภาษา มหาวิทยาลัยราชภัฏอุตรดิตถ ในสวน
ของผูดูแล สามารถเปดใชงานได โดยคลิกไปท่ี Start > All Programs > LC Material > 
LC Material 2007  

2. หนาจอหลักของการเขาใชระบบใหบริการวัสดุสารสนเทศของศูนยภาษา มหาวิทยาลัย
ราชภัฏอุตรดิตถ ในสวนของผูดูแลระบบจะปรากฏดังรูป ข.1 

 
รูป ข.1 หนาจอหลักระบบใหบริการวัสดสุารสนเทศของศูนยภาษา 

มหาวิทยาลัยราชภัฏอุตรดิตถ ในสวนของผูดูละบบ 
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จากรูป ข.1 สามารถอธิบายสวนประกอบตาง ๆ ไดดังนี ้
  หมายเลข 1 รหัสผูใชงาน ปอนรหัสผูดูแลระบบเพื่อเขาสูระบบ 
  หมายเลข 2 รหัสผานผูใชงาน ปอนรหัสผานผูดูแลระบบเพ่ือเขาสูระบบ 

หมายเลข 3 ตกลง เพื่อยืนยนัการเขาใชงานระบบใหบริการวัสดุสารสนเทศของ
ศูนยของภาษา มหาวิทยาลัยราชภัฏอุตรดิตถ ในสวนของผูดูแลระบบ 

หมายเลข 4 ออกจากระบบ 
 
ข.2 หนาจอการทํางานระบบ 
 เม่ือผูดูแลระบบกรอกรหัสผูใชและรหัสผานถูกตอง และยืนยันการเขาใชระบบแลว ระบบ
ใหบริการวัสดุสารสนเทศของศูนยของภาษา มหาวิทยาลัยราชภัฏอุตรดิตถ โดยหนาจอการทํางาน
ในสวนของผูดูแลระบบสามารถ แสดงดังรูป ข.2  
 

 
รูป ข.2 หนาจอทํางานหลักของผูดูแลระบบ 

 
หนาจอทํางานหลักของผูดูแลระบบ ประกอบดวยเมนูการทํางานตางๆ ท่ีอํานวยความ

สะดวกและ สนับสนุนการทํางานของผูดูแลระบบ ดังรูป ข.3  
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รูป ข.3 เมนูการทํางานหนาจอทํางานหลักของผูดูแลระบบ 

 
จากรูป ข.3 สามารถอธิบายสวนประกอบตาง ๆ ไดดังนี ้

  หมายเลข 1 รายช่ือผูใชงาน ประกอบดวยเมนูยอย แสดงดังรูป ข.4 

 
รูป ข.4 เมนูรายช่ือผูใชงาน 

 
จากรูป ข.4 สามารถอธิบายสวนประกอบตาง ๆ ไดดังนี ้

• เมนูรายช่ือผูใชระบบ สําหรับแสดงขอมูลรายช่ือผูใชระบบ 

• เมนูเพิ่ม สําหรับเพิ่มขอมูลผูใชระบบ 

• เมนูลบ สําหรับลบขอมูลผูใชระบบ 

• เมนูแกไข สําหรับแกไขขอมูลผูใชระบบ 
 

หมายเลข 2 ประวัติการใชงาน แสดงขอมูลประวัติการเขาใชระบบของผูใชงาน  
หมายเลข 3 รายงาน จดัทํารายงาน ประกอบดวยเมนยูอย แสดงดังรูป ข.5 

 
รูป ข.5 เมนูรายงาน 

หมายเลข 4 ออกจากระบบ กลับสูหนาจอล็อกอินเขาระบบ 



 

ภาคผนวก ค 
 

คูมือการใชระบบใหบริการวัสดุสารสนเทศของศูนยภาษา 
มหาวิทยาลัยราชภัฏอุตรดิตถ สําหรับเจาหนาท่ี 

 
ระบบใหบริการวัสดุสารสนเทศของศูนยของภาษา มหาวทิยาลัยราชภัฏอุตรดิตถ ในสวน

ของผูใชงาน สามารถทําตามข้ันตอนดังนี ้
 
ค.1 หนาจอหลักของการเขาใชระบบ 

3. ระบบใหบริการวัสดุสารสนเทศของศูนยภาษา มหาวิทยาลัยราชภัฏอุตรดิตถ ในสวน
ของผูใชงาน สามารถเปดใชงานได โดยคลิกไปท่ี Start > All Programs > LC Material 
> LC Material 2007  

4. หนาจอหลักของการเขาใชระบบใหบริการวัสดุสารสนเทศของศูนยภาษา มหาวิทยาลัย
ราชภัฏอุตรดิตถ ในสวนของผูใชงานจะปรากฏดังรูป ค.1 

 
รูป ค.1 หนาจอหลักระบบใหบริการวัสดสุารสนเทศของศูนยภาษา 
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มหาวิทยาลัยราชภัฏอุตรดิตถ ในสวนของผูใชงาน 
จากรูป ค.1 สามารถอธิบายสวนประกอบตาง ๆ ไดดังนี ้

  หมายเลข 1 รหัสผูใชงาน ปอนรหัสผูใชงานเพ่ือเขาสูระบบ 
  หมายเลข 2 รหัสผานผูใชงาน ปอนรหัสผานใชงานเพื่อเขาสูระบบ 

หมายเลข 3 ตกลง เพื่อยืนยนัการเขาใชงานระบบใหบริการวัสดุสารสนเทศของ
ศูนยของภาษา มหาวิทยาลัยราชภัฏอุตรดิตถ ในสวนของผูใชงาน 

หมายเลข 4 ออกจากระบบ 
 
ค.2 หนาจอการทํางานระบบ 
 เม่ือผูใชงานกรอกรหัสผูใชและรหัสผานถูกตอง และยืนยันการเขาใชระบบแลว ระบบ
ใหบริการวัสดุสารสนเทศของศูนยของภาษา มหาวิทยาลัยราชภัฏอุตรดิตถ โดยหนาจอการทํางาน
ในสวนของผูใชงาน สามารถแสดงดังรูป ค.2  
 

 
รูป ค.2 หนาจอทํางานหลักของผูใชงาน 

หนาจอทํางานหลักของผูใชระบบ ประกอบดวยเมนูการทํางานตางๆ ท่ีอํานวยความสะดวก
และ สนับสนนุการทํางานของผูดูแลระบบ ดังรูป ค.3  
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รูป ค.3 เมนูหนาจอทํางานหลักของผูใชงาน 
 

จากรูป ค.3 สามารถอธิบายสวนประกอบตาง ๆ ไดดังนี ้
หมายเลข 1 ยืมคืนวัสดุสารสนเทศ เมนสํูาหรับลงช่ือผูใชบริการเขาใชศูนยภาษา 

ยืมคืนวัสดุสารสนเทศ ดังรูป ค.4 
หมายเลข 2 ผูใชบริการ เมนูสําหรับปรับปรุงขอมูลผูใชบริการ ปรับปรุงขอมูล

ประเภทผูใชบริการ ดังรูป ค.8 
หมายเลข 3 วสัดุสารสนเทศ เมนูสําหรับปรับปรุงขอมูลวัสดุสารสนเทศ ปรับปรุง

ประเภทวัสดุสารสนเทศ ปรับปรุงระเบียบการใชวัสดุสารสนเทศ ดังรูป ค.21 
หมายเลข 4 โปรแกรมมัลติมีเดีย เมนูสําหรับปรับปรุงขอมูลโปรแกรมมัลติมีเดีย 

ปรับปรุงขอมูลการใชโปรแกรมมัลติมีเดียของผูใชบริการ ดังรูป ค.28 
หมายเลข 5 ขอมูลสารสนเทศ เมนูสําหรับแสดงจํานวนผูเขาใชบริการศูนยภาษา 

สถิติจํานวนยืมวัสดุสารสนเทศ จํานวนยืมวัสดุสารสนเทศตามประเภทวัสดุสารสนเทศ 
จํานวนการเขาใชโปรแกรมมัลติมีเดีย สถิติเขาใชศูนยภาษา ดังรูป ค.31 

 เมนูสําหรับลงช่ือผูใชบริการเขาใชศูนยภาษา ยืมคืนวัสดสุารสนเทศ แสดงดังรูป ค.4 
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รูป ค.4 เมนูลงช่ือผูใชบริการเขาใชศูนยภาษา ยืมคืนวัสดสุารสนเทศ 

 
จากรูป ค.4 เมนูยืมคืนวัสดุสารสนเทศ สามารถอธิบายสวนประกอบตาง ๆ ไดดังนี ้

• จากรูป ค.4 เมนูลงช่ือเขาใชศูนยภาษา แสดงข้ันตอนทํางาน ดังรูป ค.5 

 
รูป ค.5 เมนูลงช่ือเขาใชศูนยภาษา 

 
จากรูป ค.5 เมนูลงช่ือเขาใชศูนยภาษา เม่ือคลิกท่ีปุมลงช่ือเขาใชศูนย ตาม

หมายเลข 1 จะปรากฏชองกรอกรหัสผูใชบริการตามหมายเลข 2 เม่ือกรอกรหัส
ผูใชบริการครบแลวคลิกปุมลงชื่อ ตามหมายเลข 3 ขอมูลผูใชบริการจะปรากฏท่ี
หนาจอทํางานบริเวณหมายเลข 4 

เมนูยืมคืนวัสดุสารสนเทศ ยังประกอบดวยเมนูจัดทํารายงาน ซ่ึงประกอบ
ไปดวยรายงานผูใชศูนย และสถิติการเขาใชศูนยภาษา 

o รายงานผูใชศูนยจะแสดงรายงานขอมูลรายช่ือผูลงช่ือเขาใชศูนยภาษา
รายวัน แสดงดังรูป ค.6   

o สถิติการเขาใชศูนยภาษาแสดงรายงานจํานวนผูเขาใชบริการตอวัน 
แสดงดังรูป ค.7 
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รูป ค.6 ตัวอยางรายงานขอมูลรายช่ือผูลงช่ือเขาใชศูนยภาษารายวนั 

 

 
รูป ค.7 ตัวอยางรายงานจํานวนผูเขาใชบริการตอวัน 

• จากรูป ค.4 เมนูรายการยืม เม่ือผูใชบริการตองการยืมวัสดุสารสนเทศ มี
ข้ันตอนการยมื ดังรูป ค.8 
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รูป ค.8 เมนูยืมวัสดุสารสนเทศ 

 
จากรูป ค.8 เมนูยืมวัสดุสารสนเทศ เม่ือคลิกท่ีปุมยืมวัสดุสารสนเทศ ตาม

หมายเลข 1 จะปรากฏชองกรอกรหัสผูใชบริการตามหมายเลข 2 เม่ือกรอกรหัส
ผูใชบริการครบแลวคลิกปุมลงคนหา ตามหมายเลข 3 ถารหัสผูใชบริการถูกตอง 
จะปรากฏขอมูลผูใชบริการดังรูป ค.9 

 
รูป ค.9 รหัสผูใชบริการถูกตอง 

 
ในกรณีท่ีหาขอมูลผูใชบริการไมพบ ระบบจะแจงเตือนไมพบรหัส

ผูใชบริการ จากน้ันกรอกรหัสวัสดุสารสนเทศท่ีตองการยืมลงในชองหมายเลข 4 
แลวกดเพิ่มรายการวัสดุสารสนเทศท่ียืมตามหมายเลข 5 จะปรากฏขอมูลวัสดุ
สารสนเทศบริเวณหมายเลข 6 ทําซํ้าหมายเลข 4 เม่ือมีการยืมวัสดุสารสนเทศหลาย
รายการเม่ือลงรายการวัสดุสารสนทเทศท่ีตองการยืมครบแลว กดบันทึกรายการยืม
เพื่อยืนยันการยืมวัสดุสารสนเทศ ตามรูป ค.9 หมายเลข 7 
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เมนูยืมวัสดุสารสนเทศ ประกอบดวยเมนูรายงานการยืม เมนูรายงานคาง
สง และใบแจงเตือนคางสงวัสดุสารสนเทศ  

o รายงานการยืมจะแสดงผลดังรูป ค.10  
o รายงานคางสง จะแสดงผลดงัรูป ค.11 
o ใบแจงเตือนคางสงวัสดุสารสนเทศ จะปรากฏขึ้นเม่ือมีการตรวจสอบ

พบวาผูใชบริการที่กําลังยืมวัสดุสารสนเทศมีรายการคางสงวัสดุ
สารสนเทศอยู เพื่อแจงเตือนคางสงวัสดุสารสนเทศ ดังรูป ค.12 
 

 

 
 

รูป ค.10 ตัวอยางรายงานการยืม 
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รูป ค.11 ตัวอยางรายงานคางสง 
 

 
รูป ค.12 ตัวอยางใบแจงเตือนคางสงวัสดุสารสนเทศ 
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• จากรูป ค.4 เมนูรายการคืนวสัดุสารสนเทศ สําหรับคืนวัสดุสารสนเทศท่ียืมไป
โดยผูใชบริการดังรูป ค.13 

 
รูป ค.13 หนาจอคืนวัสดุสารสนเทศ 

 
เมนูรายการคืนวัสดุสารสนเทศ ประกอบดวยรายงานรายการคืนวัสดุ

สารสนเทศ สําหรับแสดงรายการคืนวัสดสุารสนเทศ แสดงดังรูป ค.14 และรายงาน
คาปรับ สําหรับแสดงรายการคาปรับและสรุปยอดรวมคาปรับกรณีท่ีสงคืนวัสดุ
สารสนเทศลาชา แสดงดังรูป ค.15 

 
รูป ค.14 ตัวอยางรายงานการคืน 
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รูป ค.15 ตัวอยางรายงานคาปรับ 

 

• จากรูป ค.4 เมนูคูมือใชงาน สําหรับแสดงคูมือใชงาน ดงัรูป ค.16 

 
รูป ค.16 เมนูคูมือใชงานสําหรับเจาหนาท่ี 

 

• จากรูป ค.4 เมนูออกจากระบบ สําหรับออกจากระบบ 
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ผูใชบริการ เมนูสําหรับปรับปรุงขอมูลผูใชบริการ ปรับปรุงขอมูลประเภท
ผูใชบริการ ดังรูป ค.17 

 
รูป ค.17 เมนูผูใชบริการ 

จากรูป ค.17 เมนูผูใชบริการ สามารถอธิบายสวนประกอบตาง ๆ ไดดังนี้ 

• เมนูผูใชบริการ เมนูสําหรับแสดงและปรับปรุงขอมูลผูใชบริการ ดังรูป ค.18 

 
รูป ค.18 เมนูแสดงและปรับปรุงขอมูลผูใชบริการ 

   เมนูผูใชบริการ ประกอบดวยรายงานขอมูลผูใชบริการ ดังรูป ค.19 

 
รูป ค.19 ตัวอยางรายงานขอมูลผูใชบริการ 
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• เมนูประเภทผูใชบริการ เมนสํูาหรับแสดงปรับปรุงขอมูลประเภทผูใชบริการ 
ดังรูป ค.20 

 
รูป ค.20 เมนูแสดงและปรับปรุงขอมูลประเภทผูใชบริการ 

 
เมนูประเภทผูใชบริการประกอบดวยรายงานขอมูลประเภทผูใชบริการดัง

รูป ค.21 

 
รูป ค.21 ตัวอยางรายงานขอมูลประเภทผูใชบริการ 

 
วัสดุสารสนเทศ เมนูสําหรับปรับปรุงขอมูลวัสดุสารสนเทศ ปรับปรุงประเภทวัสดุ

สารสนเทศ ปรับปรุงระเบียบการใชวัสดุสารสนเทศ ดังรูป ค.22 

 
รูป ค.22 เมนูวสัดุสารสนเทศ 
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จากรูป ค.22 เมนูวัสดุสารสนเทศสามารถอธิบายสวนประกอบตาง ๆ ไดดังนี ้

• เมนูขอมูลวัสดุสารสนเทศ เมนูสําหรับแสดงและปรับปรุงขอมูลวัสดุ
สารสนเทศ ดังรูป ค.23 

 
รูป ค.23 เมนูแสดงและปรับปรุงขอมูลวัสดุสารสนเทศ 

 
เมนูขอมูลวัสดุสารสนเทศ ประกอบดวยรายงานขอมูลวสัดุสารสนเทศ ดัง

รูป ค.24 

 
รูป ค.24 ตัวอยางขอมูลขอมูลวัสดุสารสนเทศ 
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• เมนูประเภทวสัดุสารสนเทศ เมนูสําหรับแสดงและปรับปรุงขอมูลประเภท
วัสดุสารสนเทศ ดังรูป ค.25 

 
รูป ค.25 เมนูแสดงและปรับปรุงประเภทวสัดุสารสนเทศ 

เมนูประเภทวสัดุสารสนเทศ ประกอบดวยรายงานประเภทขอมูลวัสดุ
สารสนเทศ ดังรูป ค.26  

 
รูป ค.26 ตัวอยางรายงานประเภทขอมูลวัสดสุารสนเทศ 



 93 

• เมนูระเบียบการใชวัสดุสารสนเทศ เมนูสําหรับแสดงและปรับปรุงขอมูล
ระเบียบการใชวัสดุสารสนเทศ ดังรูป ค.27 

 
รูป ค.27 เมนูแสดงและปรับปรุงประเภทวสัดุสารสนเทศ 

    
เมนูระเบียบการใชวัสดุสารสนเทศ ประกอบดวยรายงานระเบียบการใช

วัสดุสารสนเทศ ดังรูป ค.28 

 
รูป ค.28 ตัวอยางรายงานระเบียบการใชวัสดุสารสนเทศ 
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โปรแกรมมัลติมีเดีย เมนูสําหรับปรับปรุงขอมูลโปรแกรมมัลติมีเดีย ปรับปรุงขอมูลการใช
โปรแกรมมัลติมีเดียของผูใชบริการ ดังรูป ค.29 

 
รูป ค.29 เมนูโปรแกรมมัลติมีเดีย 

จากรูป ค.29 เมนูโปรแกรมมัลติมีเดียสามารถอธิบายสวนประกอบตาง ๆ ไดดังนี ้

• เมนูขอมูลโปรแกรมมัลติมีเดยี เมนูสําหรับแสดงและปรับปรุงขอมูล
โปรแกรมมัลติมีเดีย ดังรูป ค.30 

 
รูป ค.30 เมนูปรับปรุงขอมูลโปรแกรมมัลติมีเดีย 

 

• เมนูขอมูลการใชโปรแกรมมัลติมีเดีย เมนูสําหรับแสดงขอมูลการเขาใช
โปรแกรมมัลติมีเดียดังรูป ค.31 ปรับปรุงขอมูลการใชโปรแกรมมัลติมีเดีย ดัง
รูป ค.32 และ เมนูคนหาผูใชบริการที่ไดกําหนดการเขาใชโปรแกรมมัลติมีเดีย 
ดังรูป ค.33 
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รูป ค.31 เมนูแสดงขอมูลการใชโปรแกรมมัลติมีเดีย 

 

 
รูป ค.32 เมนูแสดงปรับปรุงขอมูลการใชโปรแกรมมัลติมีเดีย 

 

 
รูป ค.33 เมนูคนหาผูใชบริการท่ีไดกําหนดการเขาใชโปรแกรมมัลติมีเดยี 
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เมนูขอมูลสารสนเทศ ประกอบดวยเมนูจัดทํารายงานสําหรับอาจารย ผูอํานวยการ ดังรูป 
ค.34 และรายงานขอมูลการเขาใชโปรแกรมมัลติมีเดียของนักศึกษาสําหรับผูสอน 

 
รูป ค.34 เมนูขอมูลสารสนเทศ 

 
จากรูป ค.33 เมนูยอยสถิติการใชวัสดุสารสนเทศจะประกอบไปดวยเมนูสําหรับ
เลือกรายการเพื่อจัดทํารายงานดังนี ้

1) จํานวนผูใชบริการ ดังรูป ค.35 
2) จํานวนยืมวัสดุสารสนเทศแยกตามประเภทวัสดุสารสนเทศ ดัง

รูป ค.36 
3) จํานวนยืมวัสดุสารสนเทศแยกตามรายการ ดังรูป ค.37 
4) จํานวนการเขาใชโปรแกรมมัลติมีเดีย ดังรูป ค.38 
5) จํานวนการเขาใชโปรแกรมมัลติมีเดียตามกลุมเรียน ดังรูป ค.39 

 

 
รูป ค.35 รายงานจํานวนผูใชบริการเขาใชศูนยภาษา  
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รูป ค.36 ตัวอยางรายงานสถิติการใชวัสดุสารสนเทศแยกตามประเภทวสัดุสารสนเทศ 

 

 
รูป ค.37 จํานวนยืมวัสดุสารสนเทศแยกตามรายการ 
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รูป ค.38 จํานวนการเขาใชโปรแกรมมัลติมีเดีย 

รูป ค.39 จํานวนการเขาใชโปรแกรมมัลติมีเดียตามกลุมเรียน 



 
ภาคผนวก ง  

 
คูมือการใชระบบใหบริการวัสดุสารสนเทศของศูนยภาษา 

มหาวิทยาลัยราชภัฏอุตรดิตถ สําหรบัผูใชบรกิาร 
 
ระบบใหบริการวัสดุสารสนเทศของศูนยของภาษา มหาวทิยาลัยราชภัฏอุตรดิตถ ในสวน

ของผูใชบริการ พัฒนาข้ึนเพือ่ใหการเขาใชบริการโปรแกรมมัลติมีเดียมีความสะดวก เปนโปรแกรม
ท่ีสรางเมนูเพือ่ใหผูเขาใชบริการสามารถเลือกใชโปรแกรมมัลติมีเดียตามท่ีตนเองสนใจ สามารถทํา
ตามข้ันตอนดงันี้ 
 
ง.1 หนาจอหลักของการเขาใชระบบ 

5. ระบบใหบริการวัสดุสารสนเทศของศูนยภาษา มหาวิทยาลัยราชภัฏอุตรดิตถ ในสวน
ของผูใชบริการ จะทําการเปดระบบโดยอัตโนมัติหลังเปดใชงานระบบปฏิบัติวินโดวส 
ในกรณีท่ีไมสามารถเปดระบบโดยอัตโนมัติไดนั้น สามารถเปดใชงานได โดยคลิกไป
ท่ี Start > All Programs > LC Student > LC Student 2007  

6. หนาจอหลักของการเขาใชระบบใหบริการวัสดุสารสนเทศของศูนยภาษา มหาวิทยาลัย
ราชภัฏอุตรดิตถ ในสวนของผูใชบริการจะปรากฏดังรูป ง.1 

 
รูป ง.1 หนาจอหลักของการเขาใชระบบใหบริการวัสดสุารสนเทศของศูนยภาษา 

มหาวิทยาลัยราชภัฏอุตรดิตถ ในสวนของผูใชบริการ 
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 จากรูป ง.1 สามารถอธิบายสวนประกอบตาง ๆ ไดดังนี ้
  หมายเลข 1 รหัสผูใชบริการ ปอนรหัสผูใชบริการเพื่อเขาสูระบบ 
  หมายเลข 2 รหัสผานผูใชบริการ ปอนรหสัผานผูใชบริการเพื่อเขาสูระบบ 

หมายเลข 3 ตกลง เพื่อยืนยนัการเขาใชงานระบบใหบริการวัสดุสารสนเทศของ
ศูนยของภาษา มหาวิทยาลัยราชภัฏอุตรดิตถ ในสวนของผูใชบริการ 

หมายเลข 4 Guest Login เขาใชงานระบบใหบริการวสัดสุารสนเทศของศูนยของ
ภาษา มหาวิทยาลัยราชภัฏอุตรดิตถ ในสวนของผูใชบริการ โดยไมมีการบันทึกขอมูลการ
เขาใชโปรแกรม เหมาะสําหรับผูใชบริการที่ไมรหัสผูใชบริการ แตตองการเขาใชโปรแกรม
มัลติมีเดีย 

หมายเลข 5 ออกจากระบบ 
 

ง.2 หนาจอทํางานหลักของผูใชบริการท่ีลงรหัสผูใชบริการ 
 เม่ือผูใชบริการลงช่ือผูใชบริการและรหัสผานผูใชบริการถูกตอง และยืนยันการเขาใช
ระบบแลว ระบบใหบริการวัสดุสารสนเทศของศูนยของภาษา มหาวิทยาลัยราชภัฏอุตรดิตถ โดย
หนาจอในสวนของผูใชบริการสามารถแสดงดังรูป ง.2  
 

 
รูป ง.2 หนาจอทํางานหลักของผูใชบริการที่ลงรหัสผูใชบริการ 

 
 หนาจอทํางานหลักของผูใชบริการที่ลงรหัสผูใชบริการ ประกอบดวยเมนูการทํางานตางๆ 
ท่ีอํานวยความสะดวกและ สนับสนุนการทํางานของผูใชบริการ ดังรูป ง.3  
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รูป ง.3 เมนูการทํางานหนาจอทํางานหลักของผูใชบริการที่ลงรหัสผูใชบริการ 

 
จากรูป ง.3 สามารถอธิบายสวนประกอบตาง ๆ ไดดังนี ้
 รูป ง.3 หมายเลข 1 ขอมูลผูใชบริการ ประกอบดวยเมนยูอย แสดงดังรูป ง.4  

 
รูป ง.4 เมนูขอมูลผูใชบริการ 

 
  จากรูป ง.4 สามารถอธิบายสวนประกอบตาง ๆ ไดดังนี ้

หมายเลข 1.1 Home สําหรับแสดงหนาจอแสดงขอมูลขาวสารที่แจงให
ผูใชบริการทราบ 

หมายเลข 1.2 แสดงขอมูลรายการคางสงวสัดุสารสนเทศของผูใชบริการ 
เพื่อแจงใหผูใชบริการทราบ ดัง รูป ง.5 

 

 
รูป ง.5 หนาจอแสดงรายการยืมวัสดุสารสนเทศ 

 
 



 

 

102 

 จากรูป ง.3 หมายเลข 2 โปรแกรมมัลติมีเดยี ประกอบดวยเมนยูอย แสดงดังรูป ง.6  

 
รูป ง.6 เมนูโปรแกรมมัลติมีเดีย 

จากรูป ง.6 สามารถอธิบายสวนประกอบตาง ๆ ไดดังนี ้
 หมายเลข 2.1 โปรแกรมท่ีผูสอนกําหนด คือโปรแกรมมัลติมีเดียท่ีอาจารย

ผูสอนไดกําหนดใหผูใชบริการเขามาศึกษา โดยมีหนาจอการทํางานแสดงดังรูป ง.7 

 
รูป ง.7 หนาจอทํางานโปรแกรมมัลติมีเดียท่ีอาจารยผูสอนไดกําหนดใหผูใชบริการเขามาศึกษา 
 

 หมายเลข 2.2 โปรแกรมท่ีใหบริการ คือโปรแกรมมัลติมีเดียท่ีศูนยภาษา
ใหบริการสําหรับผูใชบริการเขามาศึกษา โดยมีหนาจอการทํางานแสดงดังรูป ง.8 

 
รูป ง.8 หนาจอโปรแกรมมัลติมีเดียท่ีใหบริการของศูนยภาษา 
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จากรูป ง.3 หมายเลข 3 วีดีโอแนะนําศูนยภาษา เปนวีดีโอท่ีจัดทําข้ึนเพื่อแนะนําขอมูล
พื้นฐานของศูนยภาษา มหาวิทยาลัยราชภัฏอุตรดิตถใหกับผูใชบริการ แสดงดังรูป ง.9 

 
รูป ง.9 เมนูวีดโีอแนะนําศูนยภาษาสําหรับผูใชบริการ 

จากรูป ง.3 หมายเลข 4 รายงาน แสดงขอมูลการเขาใชงานโปรแกรมมัลติมีเดียของผูเขาใช
บริการ แสดงดังรูป รูป ง.10 

 
รูป ง.10 เมนูรายงานการเขาใชโปรแกรมมัลติมีเดีย 
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จากรูป ง.3 หมายเลข 5 คูมือการใชงาน แสดงคูมือการใชงานระบบระบบใหบริการวัสดุ
สารสนเทศของศูนยของภาษา มหาวิทยาลัยราชภัฏอุตรดิตถ ในสวนของผูใชบริการดังรูป ง.11 

 
รูป ง.11 คูมือการใชระบบระบบใหบริการวัสดุสารสนเทศของศูนยของภาษา 

มหาวิทยาลัยราชภัฏอุตรดิตถ ในสวนของผูใชบริการ 
 
 จากรูป ง.3 หมายเลข 6 ออกจากระบบ กลับไปยังหนาจอเขาสูระบบ 
 
ง.3 หนาจอทํางานหลักของผูใชบริการลงชือ่เขาใชแบบผูใชท่ัวไป (Guest Login) 

เม่ือผูใชบริการ ลงช่ือเขาใชระบบแบบผูใชท่ัวไป (Guest Login) ระบบใหบริการวัสดุ
สารสนเทศของศูนยของภาษา มหาวิทยาลัยราชภัฏอุตรดิตถ โดยหนาจอทํางานหลักของผูใชบริการ
ลงช่ือเขาใชแบบผูใชท่ัวไป (Guest Login) สามารถแสดงดังรูป ง.12 

 
รูป ง.12 หนาจอทํางานหลักของผูใชบริการลงช่ือเขาใชแบบผูใชท่ัวไป (Guest Login) 
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หนาจอทํางานหลักของผูใชบริการลงช่ือเขาใชแบบผูใชท่ัวไป (Guest Login) ประกอบ 
ดวยเมนูการทํางาน ท่ีอํานวยความสะดวกและสนับสนุนการทํางานของผูใชบริการ ดังรูป ง.13 

 

 
รูป ง.13 เมนูการทํางานหลักของผูใชบริการลงช่ือเขาใชแบบผูใชท่ัวไป (Guest Login) 

 
จากรูป ง.13 สามารถอธิบายสวนประกอบตาง ๆ ไดดังนี ้

หมายเลข 1 Home สําหรับแสดงหนาจอแสดงขอมูลขาวสารที่แจงใหผูใชบริการ
ทราบ ดังรูป ง.14 

 

 
รูป ง.14 หนาจอแสดงขอมูลขาวสารที่แจงใหผูใชบริการ ลงช่ือเขาใชแบบผูใชท่ัวไป (Guest Login) 

 
จากรูป ง.13 หมายเลข 2 โปรแกรมท่ีใหบริการ คือโปรแกรมมัลติมีเดียท่ีศูนยภาษา

ใหบริการสําหรับผูใชบริการเขามาศึกษา โดยมีหนาจอการทํางานแสดงดังรูป ง.15 
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รูป ง.15 เมนูโปรแกรมท่ีใหบริการ 

 
จากรูป ง.13 หมายเลข 3 วีดีโอแนะนําศูนยภาษา เปนวีดีโอท่ีจัดทําข้ึนเพื่อแนะนํา

ขอมูลพื้นฐานของศูนยภาษา มหาวิทยาลัยราชภัฏอุตรดิตถใหกับผูใชท่ัวไป แสดงดังรูป 
ง.16 
 

 
รูป ง.16 เมนูวดีีโอแนะนําศูนยภาษสําหรับผูใชท่ัวไปา 

 
จากรูป ง.13 หมายเลข 4 คูมือการใชงานแสดงดังรูป ง.17 
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รูป ง.17 เมนูคูมือการใชงานสําหรับผูใชท่ัวไป 

 
จากรูป ง.13 หมายเลข 5 ออกจากระบบ สําหรับออกจากระบบ 

 



 

ภาคผนวก จ 
 

แบบประเมนิผลความพึงพอใจ 
การใชระบบใหบริการวัสดุสารสนเทศของศูนยภาษา มหาวิทยาลัยราชภัฏอตุรดิตถ 

 
สําหรับนักศึกษา 

คําชี้แจง 
แบบประเมินผลนี้ เปนแบบประเมินผลเพือ่ประเมินความพึงพอใจการใชระบบใหบริการ

วัสดุสารสนเทศของศูนยภาษา มหาวิทยาลัยราชภัฏอุตรดิตถ  กรุณาตอบแบบประเมินนี้ตามความ
เปนจริง และแสดงความคิดเห็นเพื่อประโยชนในการพัฒนาระบบตอไป   

 

โปรดขีดเคร่ืองหมาย  ลงในระดบัความพึงพอใจของนักศึกษาตอการใชระบบ 
 

ระดับความพงึพอใจ 

ลําดับ รายละเอียดการประเมิน 

มา
กที่

สุด
  

มา
ก 

ปา
นก

ลา
ง 

นอ
ย  

นอ
ยที่

สุด
 

ความสะดวกที่ไดรับจากระบบ             

1 ลดระยะเวลาในการรับบริการ      

2 มีความสะดวกในการรับบริการ      

3 มีความถูกตอง และเช่ือถือได      

4 
ตรวจสอบสิทธิ และรายการเขาใชโปรแกรม
มัลติมีเดีย 

     

 
ขอเสนอแนะในการปรับปรุงและพัฒนาโปรแกรม 
……………………………………………………………………………………………………… 
……………………………………………………………………………………………………… 
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แบบประเมินผลความพงึพอใจ 
การใชระบบใหบริการวัสดุสารสนเทศของศูนยภาษา มหาวิทยาลัยราชภัฏอุตรดติถ 

 
สําหรับเจาหนาท่ี 

คําชี้แจง 
แบบประเมินผลนี้ เปนแบบประเมินผลเพือ่ประเมินความพึงพอใจการใชระบบใหบริการ

วัสดุสารสนเทศของศูนยภาษา มหาวิทยาลัยราชภัฏอุตรดิตถ  กรุณาตอบแบบประเมินนี้ตามความ
เปนจริง และแสดงความคิดเห็นเพื่อประโยชนในการพัฒนาระบบตอไป   

 
โปรดขีดเคร่ืองหมาย  ลงในระดบัความพึงพอใจของนักศึกษาตอการใชระบบ 

ระดับความพงึพอใจ 

ลําดับ รายละเอียดการประเมิน 

มา
กที่

สุด
  

มา
ก 

ปา
นก

ลา
ง 

นอ
ย  

นอ
ยที่

สุด
 

การใชงานระบบ           
1 การออกแบบหนาจอเพื่อติดตอกับผูใชงาน      

2 ความสะดวกในการใชงานบันทึกขอมูล      

3 คําอธิบายการใชงานท่ีชัดเจน      

4 การปองกันการเขาถึง (ระบบ Login)      

5 ลดระยะเวลาและมีความสะดวกในการทํางาน      

6 ลดความผิดพลาดในการจดัเก็บและรวบรวม
ขอมูลในรูปแบบเอกสาร 

     

7 การรายงานของระบบครอบคลุมตามความ
ตองการ 

     

8 มีความถูกตอง และเช่ือถือได      
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ระดับความพงึพอใจ 

ลําดับ รายละเอียดการประเมิน 

มา
กที่

สุด
  

มา
ก 

ปา
นก

ลา
ง 

นอ
ย  

นอ
ยที่

สุด
 

การใชงานระบบ           

1 หนาจอสําหรับทํารายการ      

2 ระบบล็อกอิน (Login)      

3 ระบบจัดการขอมูล      

4 ระบบออกรายงาน      

 
ขอเสนอแนะในการปรับปรุงและพัฒนาโปรแกรม 
……………………………………………………………………………………………………… 
……………………………………………………………………………………………………… 
……………………………………………………………………………………………………… 

 
ขอขอบคุณท่ีใหความรวมมือในการตอบแบบสอบถาม 

 

 



 

ประวัติผูเขียน 
 
 

ช่ือ นายสมชาย   คําวรรณะ 
 
วัน เดือน ป เกิด 19 มิถุนายน 2521 
 
ประวัติการศึกษา สําเร็จการศึกษามัธยมศึกษาตอนปลาย 

 แผนการเรียนศิลปศาสตร-คณิตศาสตร 
 โรงเรียนสา  อ.เวียงสา  จังหวัดนาน 
 ป พ.ศ. 2539 
 
 สําเร็จการศึกษาปริญญาวิทยาศาสตรบัณฑิต 

 โปรแกรมวิชาวิทยาการคอมพิวเตอร 
 สถาบันราชภัฎอุตรดิตถ   จังหวัดอุตรดิตถ 
 ป พ.ศ. 2543 
 
ประสบการณ พ.ศ. 2543 – 2544 

เจาหนาท่ีระบบคอมพิวเตอร 
 โรงพยาบาลอุตรดิตถ อําเภอเมือง จังหวัดอุตรดิตถ 
 
 พ.ศ. 2544 – ปจจุบัน 
 นักวิชาการคอมพิวเตอร 
 ศูนยภาษา  มหาวิทยาลัยราชภัฏอุตรดิตถ  
 อําเภอเมือง   จงัหวัดอุตรดิตถ 
   
 
  
 
  

 
 


